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INTRODUCTION

Welcome to Mastercam 2018! Mastercam 2018 features new functionality focused on
delivering speed and efficiency to your machining jobs.

Product Changes
Two changes have beenmade to the Mill Entry product. The 2D chamfer Contour
type is now available for a 2D Contour toolpath. The Rough Cutting methods, Con-
stant Overlap Spiral and Parallel Spiral are also now available for a 2D Pocket
toolpath.

Mastercam Resources
Enhance your Mastercam experience by using the following resources:

l Mastercam Documentation—Mastercam installs a number of helpful doc-
uments for your version of software in the \Documentation folder of your
Mastercam 2018 installation.

l Mastercam Help—Access Mastercam Help by selectingHelp, Contents from
Mastercam's File tab or by pressing [Alt+H] on your keyboard.

l Mastercam Reseller—Your local Mastercam Reseller can help withmost ques-
tions about Mastercam.

l Technical Support—Our Technical Support department (860-875-5006 or
support@mastercam.com) is openMonday through Friday from 8:00 a.m. to
5:30 p.m. USA Eastern Standard Time.

l Mastercam Tutorials—We offer a series of tutorials to help registered users
become familiar with basic Mastercam features and functions. Visit our web-
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site, or selectHelp, Tutorials fromMastercam's File tab to see the latest pub-
lications.

l Mastercam University—Mastercam University, an affordable online learning
platform, gives you 24/7 access to Mastercam trainingmaterials. Take advant-
age of more than 180 videos to master skills at your own pace and help pre-
pare for Mastercam Certification. For more information onMastercam
University, please contact your AuthorizedMastercam Reseller, visit
www.mastercamu.com, or email training@mastercam.com.

l Online Communities—You can find a wealth of information at
www.mastercam.com. For tech tips and the latest Mastercam news, follow us
on Facebook (www.facebook.com/mastercam), Twitter
(www.twitter.com/mastercam), or Google+ (plus.google.com/+mastercam).
Visit our YouTube channel to see Mastercam in action
(www.youtube.com/user/MastercamCadCam)! Registered users can search
for information or ask questions on the MastercamWeb forum,
forum.mastercam.com, or use the knowledgebase at kb.mastercam.com.

Contact Us
For questions about this or other Mastercam documentation, contact the Technical
Documentation department by email at techdocs@mastercam.com.

What'sNew in Mastercam 2018— Introduction
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GENERAL ENHANCEMENTS

Listed below are general enhancements made to Mastercam 2018. This includes
improvements to selection, general toolpath enhancements, and other functions not
specific to one product line.

Analyze Enhancements
Listed below are enhancements made to the Analyze functions, located on the Home
tab.

Analyze Toolpath

5-axis vector information

Analyze Toolpath now includes XYZ location data corresponding to the mouse location
at the start (green) or end (red) of the toolpath segment. This information is in addi-
tion to the feed and speed data that is shown between the start and end of the seg-
ment.
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Display options

You can choose to display or hide the tool and holder during Analyze Toolpath. Use
the Opacity slider to control their translucency.

What'sNew in Mastercam 2018—General Enhancements
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Analyze Distance Along Curve
A new Analyze function is now available on the Home tab, under Analyze Distance.
Analyze Distance Along Curve allows you to find the distance along a line, arc, or
spline edge without having to trim or break it first.

Unlike Analyze Distance, Analyze Distance Along Curve does not measure a linear dis-
tance, but rather the length along the curve between two user-defined points.

This function reports the following position coordinates as they relate to the Cplane
origin:

l Distance

l Start angle

l End angle

l Sweep angles
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Lathe coordinates
Analyze Position now displays when a DZ construction plane is now active.

Propagate arc radius
When using Analyze Entity on an arc or radius, you can now apply a diameter to all
selected arcs by selecting Propagate arc radius on the dialog box.

Statistics
Statistics now reports the number of sheet solids in the current part file.

What'sNew in Mastercam 2018—General Enhancements
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Bounding Box Face Points
In Mastercam 2017, Face center points were introduced and were tied to Center
points. Now, Face center points and Center points are independent of each other.

You can use the Center point option to create a single point in the middle of the
Bounding Box and/or use the Face center points option to create points at the center
of each face, or use both at the same time.
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Command Finder
The Command Finder utility, which searches for and opens Mastercam functions, has
been added to the Home tab.

The Command Finder opens as a floating window that can be repositioned and
remains on-screen until you close it.

Enter a word in the Command Finder andMastercam returns a list of possible
matches that include a short description of the function.

Double-click a search result to open that function.

What'sNew in Mastercam 2018—General Enhancements
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You can also add the Command Finder to the Quick Access Toolbar (QAT), or assign it
a keyboard shortcut.

Create New Viewsheets
In Mastercam 2017, to create a new viewsheet, you had to right-click on a viewsheet
and selectNew Viewsheet.

In Mastercam 2018, you can also create new viewsheets by clickingNew to the right
of the viewsheet tabs. The new tab is highlighted, so that you can input the name
immediately after creating the viewsheet.
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Create Plane Dynamically
A new option has been added to Trim by Plane and to the Plane Selection dialog box,
that launches the New Plane function panel.

This allows you to create a dynamic plane without exiting the current function. By
default, the new plane is added to the Planes Manager.

Delete Duplicates
Delete Duplicates now identifies duplicate arcs, even when they have different start
and end angles.

What'sNew in Mastercam 2018—General Enhancements
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Dimmed and No Hidden Wireframe
STL entities can now be displayed inDimmed andNo HiddenWireframe viewmodes
as shown in the following examples.

No Hidden Dimmed

Endpoints
Endpoint display has been enhanced, now displaying as solid white circles with a black
outline to provide contrast with different geometry and background colors.

What'sNew in Mastercam 2018—General Enhancements



You can toggle Endpoints on the Home tab to display or hide geometry endpoints.
Your setting will persist across multiple sessions of Mastercam. The size of the end-
points is not configurable, and they do not scale when the screen is re-sized.

What'sNew in Mastercam 2018—General Enhancements
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General Toolpath Enhancements
Listed below are enhancements made to toolpaths that are not specific to one product
line.

Improved access to chaining tolerance
Chaining tolerance is now stored with the chains in the Chain Manager. The value in
the Chain Manager only affects the selected toolpath and is applied to all subsequent
regenerations of the operation.

Other toolpaths will continue to default to the chaining tolerance set in the Tolerances
page of System Configuration.

Probe operation associativity
Probe operations are now associated to their selected geometry. As with other oper-
ations in Mastercam, when youmove or modify the geometry used in the Probe oper-
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ation and regenerate, the operation will update with the new geometry. You no longer
need to recreate the Probe operation.

Stock display
The Stock Display and Stock Shading options, that were previously available on the
View tab in Mastercam 2017, are now located on the specific machine type tab and
have been expanded.

In the case of Mill, Router, andWire machine types, Stock Display works as it did in pre-
vious versions. For Lathe andMill-Turnmachines, you can now control which stock
components are displayed in the graphics window.

For Lathe machines, the available components must be defined in the Stock Setup
page of the Machine Group Properties dialog box. For Mill-Turnmachines, the avail-
able components depend on your Job Setup and your current machine.

If a component is not defined or available for your current machine setup, the option
is disabled from the Stock Display drop-down.

What'sNew in Mastercam 2018—General Enhancements
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Guided Chaining
You can now guide and select the next entity in a chain when a branch point has been
reached. Guided chaining is available in 3D Wireframe and Linked Edgesmode for
solids.

To use guided chaining, click a 3D wireframe or linked edge to begin chaining. When a
branch point is reached, a red arrow displays pointing in the direction of the default
next direction/entity. One or more blue arrows display pointing in the direction of any
alternate branches as shown in the following example.

Two new controls are now available on the Chaining dialog box:

Use Next to continue in the direction of the red arrow.

Use Adjust to select a different direction/entity.
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Alternately, you can click on the red or blue arrow to advance the chain in that dir-
ection.

Importing/Exporting Enhancements
Listed below are enhancements made to importing and exporting other supported file
types, such as CATIA and SOLIDWORKS files.

CATIA Translator now imports hidden entities
When importing CATIA files, Mastercam will also import any hidden entities and place
them on a level.

Keep names when exporting solid bodies
When exporting solids to other CAD formats, Mastercam will now export the solid
name data with the bodies.

Naming levels and solid bodies from imported solid assemblies
When importing solid assemblies, Mastercam's file importers use a new protocol to
populate both the Solids and Levels Manager. Mastercam processes the solid depend-
ing on what type of information is available from the incoming file format. If there is
no level or body name data in the imported file, the body and the level name are the
file name.

Levels Manager

l Level names from the imported file or assembly are preserved in the Master-
cam part file.

l Even when importing from formats with no level data, Mastercam places the
imported solid bodies on separate levels.

l The level name is based on the solid body name, when possible.

l When you open a Solid Edge, SOLIDWORKS, or Parasolid file that contains

What'sNew in Mastercam 2018—General Enhancements
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multiple solid bodies, each body is placed on its own level. When the inform-
ation is present in the original file, Mastercam assigns the solid body name to
each level. To change this behavior, deselect Assign Level names to match
Solid names on the Converters page of System Configuration.

Solids Manager

l Mastercam names and appends a number to each imported solid body in a
STEP file that contains multiple solid bodies (Filename+n).

l Mastercam organizes the various solid bodies of an assembly in the Solids
Manager.

l Whenever possible, Mastercam names each imported solid body.

l Names for imported solid bodies are independent of the imported level
names.

l Multiple bodies with the same name will have numbers appended.

l Bodies in separate part files in assemblies will include the name of the
assembly in the Solids Manager.
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New options available when importing STL files
There are new options available on the STL Read Parameters dialog box. To access
this dialog box, choose an STL file, and selectOptions in the Open dialog box.

l Create open edge geometry

l Create sharp corner edge geometry

l Offset the triangle data inward or outward

l Save the stitched and/or offset data to a new STL file

What'sNew in Mastercam 2018—General Enhancements
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Levels Manager
Listed below are enhancements made to the Levels Manager.

Ignore blanked entities in count
Select Ignore blanked entities in count from the Display options drop-down to
not include blanked entities in the Entities column count. This option is off by default.

Previously, blanked entities were included in the entity count and caused confusion
between the count and visible entities on a level.

Import via drag and drop
You can now drag and drop a supported file (for example,.csv) onto the Levels Man-
ager to automatically import that file's levels.
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Mastercam Simulator
Listed below are enhancements made to Mastercam Simulator.

Create bookmarks
You can now create bookmarks in Mastercam Simulator that refer back to various
points during Verify, Backplot, or Simulation.

You can add a bookmark, clear a bookmark, or clear all bookmarks. Use Automatic
Bookmark to insert bookmarks at certain locations, such as a tool change or oper-
ation change. The bookmarks are then displayed on the playback bar. Simply select
any bookmark icon to display the part as it is at that moment. You can also use Create
Bookmark on the playback bar to add a bookmark.

If you exit Mastercam Simulator or regenerate the toolpaths, the bookmarks are
cleared automatically. They do not persist between sessions.

What'sNew in Mastercam 2018—General Enhancements
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Create presentation
You can now create a presentation fromMastercam Simulator. Saving a presentation
lets you preserve your settings and layout of your Mastercam Simulator session and
can be used to show a simulation on any computer, even if it does not have Master-
cam.

Select Save Presentation on the Home tab to create your presentation.

Machine Simulation
A light-weight version of Machine Simulation is now available within Mastercam Sim-
ulator. Select Verify from the Toolpaths Manager, and select Simulation on the
Home tab to view the machine simulation.
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To set options for Machine Simulation inside Mastercam Simulator, select Simulator
Options on the Toolpaths Manager to display the redesigned dialog box.

Use the Components tab to set up stock and fixtures. Use the Data tab to set tol-
erances. Use the Simulation tab to set the machine, position, and tolerance.

If you do not have a machine selected when enteringMastercam Simulator, Master-
cam will default to a generic machine or a machine that was selected in the Machine
Simulation dialog box for the standalone Machine Simulation.

What'sNew in Mastercam 2018—General Enhancements
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Once inside of Simulation, you have access to the same options as you do in Verify
mode. You can use clipping planes, save the stock as an STL, or use Collision Check-
ing.
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My Mastercam
You can now access your profile and other information by logging into My Mastercam,
located in the top right corner of Mastercam 2018. Once logged in, you have access to
Mastercam's social media outlets, your Reseller information, the Mastercam forum,
and other helpful information.

Named Groups Quick Mask
The Named Groups selection filter, which was previously available in Mastercam X9,
has been added back to Quick Masks.

What'sNew in Mastercam 2018—General Enhancements
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Selecting the Select all named group entities Quick Mask, opens the Groups Man-
ager dialog box where you can select a group by name. Alternately, you can select a
member of the group, which will select the entire group.

Nesting Enhancements
Listed below are enhancements made to nesting.
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Create labels
Use Place label on top of solid to create labels on the top of the solid, instead of at
Z zero. This new option is located on the Nesting Configuration dialog box.

New location for temporary files
Temporary nesting files now go into Mastercam's default temp folder ( ...\m-
cam2018\common\TEMP) so that you can safely make them read-only if necessary.

User-defined maximum priority
You can now define the highest maximum priority value for parts and sheets in the
Nesting Configuration dialog box.

What'sNew in Mastercam 2018—General Enhancements
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New Plane/Edit Plane Function Panel
Plane creation and editing has beenmerged into a new function panel that includes
controls from previous Dynamic Plane and New Plane dialog boxes.

When creating a new plane by using the on-screen, dynamic gnomon, from the Planes
Manager, using Trim to Plane, etc., the New Plane function panel opens. When editing
an existing plane, the Edit Plane function panel opens. The function panels share the
same controls, which are enabled or disabled as appropriate for the current mode.

These new function panels follow the same design guidelines as other functions in
Mastercam, and provide a familiar work flow to users.
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The Basic tab provides all the controls to create/edit a plane, and the Advanced tab
includes planes attributes such as plane associativity and locking.

What'sNew in Mastercam 2018—General Enhancements
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Planes Manager
Listed below are enhancements made to the Planes Manager.

Import via drag and drop
You can now drag and drop a supported file onto the Planes Manager to import the
file's planes. The Plane Selection dialog box displays and lets you select which planes
to import.
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Select one or more planes to import and clickOK. The planes are imported into the
openMastercam file.

What'sNew in Mastercam 2018—General Enhancements
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Isometric reverse and trimetric planes
Two new standard planes, Iso Reverse and Trimetric, have been added to the Planes
Manager and to the Create Relative Planes dialog box.
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Saving Files Workflow
With the release of Mastercam 2017, file extensions no longer contain version num-
bers. To ensure that Mastercam does not overwrite your part, machine, and control
definition files, the save file workflow has been changed.

What'sNew in Mastercam 2018—General Enhancements
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Mastercam control definition files
When you open a Mastercam 2017 control definition file in 2018, Mastercam displays
the following warningmessage:

If you choose Yes, a backup of the original file is saved to the following location:

C:\Users\Public\Documents\shared Mcam2018\CNC_MACHINES\Older Ver-
sions\2017

If you choose No, the Save As dialog box displays, and you can rename the file using a
unique name.

Mastercammachine definition files
When you open a Mastercam 2017 machine definition file andmake a change, a
backup of the original file is automatically saved to the following location:

C:\Users\Public\Documents\shared Mcam2018\CNC_MACHINES\Older Ver-
sions\2017

Any changes made to Mastercam X9 or older versionmachine definition files are
saved with their original extension.
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Mastercam part files
When you open a Mastercam X9 or older part file in Mastercam 2018, selecting Save
opens the Save As dialog box, where you can save the file with the 2018 .mcam
format.

When you open a Mastercam 2017 part file in 2018, you will see a warning banner in
the interface that tells you the file is from a previous version of Mastercam.

If you click Save, a warning will display. Choosing Yes saves the file as a Mastercam
2018 .mcam file, and choosingNo opens the Save As dialog box.

What'sNew in Mastercam 2018—General Enhancements
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Selection Enhancements
Listed below are enhancements that have been to general selection.

Enhanced solid and surface selection
The selection of solids, surfaces, and STL entities has been improved. You can now
select different types of entities without switching between Standard and Solid modes
on the Selection Bar. These selection enhancements have been included in the fol-
lowing functions:

l Selectingmachining drive and/or check geometry for 3D toolpaths

l Wireframe, Curve All Edges

l Wireframe, Curve Slice

l Wireframe, Curve at Intersection

l Wireframe, Curve Parting Line

l Transform, Project

When selecting geometry in one of these functions, the following buttons on the Selec-
tion Bar are disabled:

l Standard Selection

l Solid Selection

l Edge Selection

The Body Selection and Face Selection filters on the Selection Bar, as well as sur-
face, solid, and polygonal mesh Quick Mask filters are supported during the selection
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process. If both the Face and Body Selection filters are enabled, the cursor will altern-
ate between face and body selection whenmoving over a solid.

Mastercam displays a prompt to guide you through selection techniques.

Hovering over a solid highlights the nearest face and displays the face selection
cursor. Click to select a solid face or double-click to select a feature. If only the Face
Selection filter is enabled, you can triple-click to select all faces of a solid body. Click
an individual face of the solid to deselect it from the body.

Use [Shift+click] to select a face and all tangent faces, or [Ctrl+click] to select similar
solid faces. In addition, you can use [Ctrl+Shift+click] to select matching fillets or
holes.

What'sNew in Mastercam 2018—General Enhancements
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Pressing [Esc] or double-clicking in an open area of the graphics window accepts the
selection.

Selection masking for sheet bodies
A new sheet solid selection capability has been added to the Select All and Select Only
dialog boxes.

Similar face selection
You can now hold [Ctrl+Shift] to select and edit similarly sized faces in a single oper-
ation for the followingModel Prep functions:

l Move

l Push/Pull

l Modify Features

l Change Face
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Window selection support
Window selection is now available in Solid Selectionmode to select solid bodies
and/or faces.

It is also supported when using the Model Prep functions, Push/Pull andHole Axis.

Setup Sheet Enhancements
Additional XML tags have been added to the database for Mastercam 2018.

Additional image support
Setup sheet can now generate these additional image types:

l JPG

l PNG

l GIF

Choose the desired format in the Setup Sheet dialog box. Also, additional XML tags
have been added to the database for Mastercam 2018.

Viewsheets and levels support
You can now include your viewsheet images in your report, or images based on levels
in views. Select Level or Viewsheet on the Capture Images dialog box to include
them into your report.

What'sNew in Mastercam 2018—General Enhancements
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Social Media Links
You can now access Mastercam's social media outlets from the Mastercam.com login
page and the Community page (accessed through the File tab). Click an icon to launch
the website.

System Configuration
Listed below are enhancements made to System Configuration.

Default file open type
You can set a default file type to be used when opening a file.
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On the Files page, choose a Default file open type from the drop-downmenu as
shown below. The setting persists from session to session.

What'sNew in Mastercam 2018—General Enhancements

50



51

Selection window color
You can now set a default color for the selection window on the Colors page.

Update to Parasolids 29.1
Mastercam 2018 has been updated to use Parasolids 29.1, the latest Parasolids ker-
nel. This upgrade allows Mastercam to do the following:

l Maintain compatibility with other CAD modelers

l Benefit from new features and capabilities, when possible

l Benefit from bug fixes within the kernel
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User Interface Changes
The following functions have been converted to function panels for Mastercam 2018.

l 2 Surface Blend

l 3 Fillet Blend

l 3 Surface Blend

l Block

l Bolt Circle

l Cone

l Create Letters

l Cross Hatch

l Cylinder

l Ellipse

l Extrude Surface

l Fillet to Curves

l Fillet to Plane

l Fillet to Surfaces

l Fit

l Helix

l Leader

l Mirror

l Note

l Offset

l Offset Contour

l Polygon

l Project

l Rectangular Array

l Rectangular Shapes

l Roll

l Rotate

l Scale

l Silhouette Boundary

l Sphere

l Spiral

l Sketch

l Torus

l Translate

l Translate 3D

l Turn Profile

What'sNew in Mastercam 2018—General Enhancements
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The interface for these functions has the same look and feel as the Solids interface,
allowing you to work in the function panel and in the graphics window simultaneously.
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Work Offsets
When you update a plane's work offset, the Update Plane dialog box now indicates
howmany operations are affected by the change. After selecting an update option,
the right side of the dialog box shows which planes will be updated.

You can select different update options and see which operations will be affected
before committing the change.

What'sNew in Mastercam 2018—General Enhancements
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XML Post Text
The Control DefinitionManager's Text page right-click menu has been enhanced. You
can now change the text item to display as User text, System column text, or as an
XML item tag.

Export Text and Export XML have been changed to only export as XML. You can no
longer output as text.
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When importing into the Control DefinitionManager, the Post Text dialog box has
been enhanced to now display the Control key and the Language key.

What'sNew in Mastercam 2018—General Enhancements
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You can also use the Post Text dialog box to remove control keys, by selecting
Remove text section from post from the right-click menu.

What'sNew in Mastercam 2018—General Enhancements



DESIGN ENHANCEMENTS

Listed below are design enhancements made to Mastercam 2018. These include
improvements to Solid, Model Prep, andWireframe functions.

Angle Sweep
To improve the creation of more complex wireframe functions and when creating or
editing primitives, there are now on-screen sweep and rotate controls.

These controls can snap to the AutoCursor positions of existing entities, including tan-
gencies. Additionally, the controls recognize horizontal and vertical snap positions
based on the gnomon orientation.

What'sNew in Mastercam 2018—Design Enhancements

58



59

l All primitives with the exception of Block now include a sweep control.

l All wireframe functions, with the exception of Polar arcs and Ellipses, now
include a sweep control.

l Rotate controls were added to the following wireframe functions: Polygon,
Ellipse, and Rectangular Shapes. This also applies to Roll, located on the Trans-
form tab.

l Helix and Spiral now include a single-axis control that lets you graphically
modify the height of the shape you are creating and editing.

Seam Control
To make Roll and Unroll results easier to predict, a new gnomon based rotation con-
trol is now available. You can visually rotate the seam to see how geometry will
respond, as well as snap to AutoCursor positions.
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Drafting Enhancements
Listed below are enhancements made to Drafting functions.

Align Note
Previously available as a C-Hook, Align Note is now available on the Drafting tab.
Align Note allows you to move existing notes and labels in such a way that they are
more organized and easier to read.

After selecting the function, select the notes you wish to align, and then choose a note
to use as the reference position. You can thenmake any adjustments needed from
the function panel.
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Cross Hatch
The Cross Hatch function has beenmoved into a function panel, allowing you to make
edits to the pattern, spacing, and angle before creating the cross hatch. Cross Hatch
is also live, allowing you to see what you are creating before accepting it.

To access the Custom Hatch Patterns dialog box, select Define on the Advanced tab.
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Leader
You can now create standalone leaders, which was previously only available in the
Note dialog box. Unlike notes, labels, and letters, leaders are not live entities and can-
not be edited.
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Smart Dimension
Enhancements made to Smart Dimensionmakes it easier to create multiple dimen-
sions and then align the dimension orientation.

l The new Parallel option aligns the dimension orientation to be parallel to your
selected geometry.

l Methods used to align dimension orientations (Auto, Horizontal, etc.) are now
available anytime you are in the function, not just after creating and placing a
dimension.

l When you select Lock, the specificMethod you have selected stays active until
you change it. You can easily create multiple dimensions using a specific ori-
entation without having to reset it.
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Model Prep Enhancements
Listed below are enhancements made to Model Prep functions.

Hole Axis
Hole Axis is now easier to use with a large number of holes, especially holes with
matching diameters that are selected as a group.

When you hold down the [Ctrl] key to select all holes with the same diameter, Master-
cam calculates the top based on the direction of the hole. The result can be undesir-
able withmultiple holes pointing in different directions.

In previous releases, you had to individually select the axis inside the hole or select
and then re-select each arrow to change the direction of the vector. In 2018, the vec-
tor arrow is larger and is selectable to make it easier to manage directions on a small
set of holes.

Direction options

The newDirection options allows you to change the direction of the holes.

l Use Defined to point the holes in the direction determined by the Orientation
option.

l Use Opposite to flip the holes opposite of the direction determined by the Ori-
entation option.

l Select Include blind holes to flip the direction of theoretical blind holes, but
not true blind holes. A true blind hole has a physical bottom inside of the solid.
A theoretical blind hole passes completely through a section of the solid.

Orientation options

Use the newOrientation options to determine the direction of the top of the holes.

l Select First pick to use the direction of the first selected hole (as defined by
the solid) and force all holes to use the same direction.
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l Select Cplane to orient the top of the selected holes to match the positive dir-
ection of the Z axis of the current Cplane.

Multiple Undo/Redo
In previous versions, any changes made to solid models using the Model Prep func-
tions could not be reverted. Now, you can undo and redo up to twenty-five Model Prep
functions using the newUndo and Redo, located on the Solids Manager.

The Model PrepUndo and Redo are unrelated to Mastercam's Undo and Redo. They
only affect changes made using the Model Prep functions. Applying a history-based
Solid function to the model clears the Undo and Redomemory stream andmakes any
previous Model Prep changes permanent.

Solid Enhancements
Listed below are enhancements made to Solid functions.

Solid Sweep
Solid Sweep now has more options and controls than in previous releases. Solid
Sweep operations from previous releases will still have limited features when edited
in Mastercam 2018. Only newly created Solid Sweep operations will support the new
options.

3D Along curve

Solid Sweep now supports 3D Along curves in addition to 2D Along curves.
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End Profile Chain(s)

End Profile Chain(s) allows you to transition from one profile to another while trav-
eling down the Along Chain.

Each profile must have an equal number of entities, but the profiles do not need to be
chained in sync. The chains must contain the same number of entities, even if the
shape is different.

Guide Chain

Use a Guide Chain to influence a Solid Sweep operation by introducing a chain that
alters the shape of the results. The images below depict the orange wireframe being
swept across the blue wireframe. The green wireframe is the Guide Chain.

l Guide Chains that are offset by 180 degrees from the Along Chain yield the
most predictable results.
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l Guide Chains are not limited to the same plane as the Along Chain.

New alignment options

Two new options have been added to control the alignment between your profile and
the Along chains. Previous releases always kept the same angle relationship between
the Profile and Along curves. You can choose one of the following:

Normal Parallel

l Normalmaintains the original angle relationship between the profile and
along chain.

l Parallel keeps the cross sections parallel to the original profile.

The ability to control this relationship makes the exact placement of the profile in rela-
tion to the Along curve less critical.

Sharp corners

Prior to this release, Solid Sweep required a fillet between entities on the Along curve
when there was a change in direction of more than 5 degrees. In Mastercam 2018,
the profile geometry easily runs along sharp corners. If any sharp corners are
encountered, Mastercammiters them.
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This enhancement gives you greater flexibility and precision whenmodeling.

Sweep Twist

Sweep Twist, under the Advanced tab, allows you to twist the profile as it travels the
Along Chain. You can control the angle of the twist as well as its placement along the
sweep. There is no limitation on the angle of the twist, and you can use the following
options to apply the twist from a certain place:

No twist Twist

l The start of the Along Chain to the end

l The start of the Profile Chain(s) to the end of the Along Chain

l The start of the Along Chain to the Profile Chain(s)

Solids Manager
Listed below are enhancements made to the Solids Manager.

New icon

A new icon has been added to the Solids Manager that represents solid bodies with
operations that have been rolled back and are dirty. This is especially helpful when
there are many solid bodies and the bodies are collapsed so the history is not dis-
played.
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Stop Operation placement

There is now a simpler way to manipulate the Stop Operation inside the history of a
solid. You can now place the Stop Operation by selecting the operation you want to be
last and selectingMove Stop Op here from the right-click menu.

To reset the Stop Operation to the end of the history tree, right-click on the Solid tree
and select Reset Stop Op.

Keep solid feature color
Mastercam now retains a solid's face and feature colors even after you have
removed its history.

Solid face masking
You can now use the standard color masking tools found in the Quick Mask color selec-
tion to select solid faces when creating a surface from a solid.
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Transform Enhancements
Listed below are enhancements made to the Transform functions.

Control start position
Rotate andMirror now include a new option, Translate, whichmaintains the same
start position of a closed circle when rotated or mirrored. If deselected, the start pos-
ition of the circle moves as it did in previous Mastercam releases.

Scale conversion
You can now easily translate between inches to millimeters, or frommillimeters to
inches when using Scale. SelectMetric or English in the Uniform group to scale your
geometry.
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Wireframe Enhancements
Listed below are enhancements made to Wireframe functions.

Curve creation
The Curve functions, Curve One Edge and Curve All Edges, have been enhanced.
These new features will help in the creation of more accurate containment bound-
aries.

Ignore adjoining solid edges

Select Ignore shared edges for Curve All Edges to identify any adjoining solid edges
of the selected solid faces and ignore them when creating a curve.

Ignore shared edges off Ignored shared edges on

Only outside loops

Curve All Edges now allows you to create curves from only exterior edges of a solid
and ignores the inner edges when you selectOnly outside loops. It is only active
when solid faces are selected.

Select tangent edges

You can now [Shift+click] to select tangent edges in Curve One Edge.
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Support for 2D and 3D modes

Curve One Edge and Curve All Edges now create geometry in both 2D and 3D mode.
Previously, these functions only supported creating geometry in 3D mode. By sup-
porting 2D geometry creation, geometry created from the selected edge can be pro-
jected to the current Cplane and Z depth, instead of requiring you to use another
function, such as Project.

Create Letters
In previous versions, creating letters could require multiple attempts in order to get
the results you wanted. Create Letters is now in a function panel, allowing you to work
simultaneously within the graphics window.

This also means that the letters are now live entities, so when you choose a new font,
reposition, or edit the text it now shows the results in the graphics window.
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Edit Spline
A new function has been added to theWireframe tab, located under the Refit Spline
drop-down. Use Edit Spline to refine and prepare splines. Edit Spline works on
NURBS splines and converts any selected lines, arcs, or parametric splines into a
NURBS.
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Edit Spline allows you to modify the tangenices andmagnitudes of a curve at the
spline's node points, or to edit tangencies at the vectors of control points. You can
move, rotate, or lengthen the tangent vector or move the control point. For more con-
trol and a finer adjustment of the curve, you can add or remove node points, or
increase the number of control points.

Helix and Spiral
Helix and Spiral function panels now include locks for specific fields. The fields you can
lock are Revolutions, Height, Pitch for helix creation, and Initial Vertical Pitch for
spiral creation. Locking allows you to specify one of the fields and then drive the oth-
ers based on permutations of the equation:

(Pitch) x (Revolutions) = Height

For example, when you are defining a helix, if you lock the Height at 10 and set the
number of Revolutions to 5, your resulting Pitch will be calculated as 2. Locking a
field does not prevent you from changing that value, it simply establishes which field is
constant and which two are calculated.
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Line Endpoint
Midpoint has been added to Line Endpoint. Select this option to create a line by select-
ing two points. The first point selected will be the midpoint and the second point will
define one end while the other end of the line is a mirror in the opposite distance and
angle.
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Modify at Intersection
A new function is now available on theWireframe tab, located in the Trim Break
Extend drop-down.Modify at Intersection allows you to trim, break, or create
points with lines, arcs, and splines where they intersect with surfaces, solid bodies,
solid faces, and solid sheet bodies. This is particularly useful whenmodeling or prep-
ping for Multiaxis toolpaths.

SelectModify at Intersection, and then use any selectionmethod to select the wire-
frame geometry that you want to edit. After selecting the wireframe, select an inter-
secting surface, face, or solid body to display the function panel.

When trimming geometry, Mastercam keeps the wireframe on the Normal side of the
surface or solid by default. To change this, click Reselect.
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TOOL ENHANCEMENTS

Listed below are tooling enhancements made to Mastercam 2018 Mill tools.

Improved Inch and Metric Support
Mastercam now supports mixing inch andmetric tools and holders when building tool
assemblies in Mill. You can use metric tools in inch part files and inch tools in metric
part files. This includes proper tool compensation and scaling in Backplot and Verify.

Note: This does not support scaling operation parameters when changing system
units.

New Tool Importers
Support was added for importing tool assemblies from CoroPlus andMachining
Cloud. Right-click in the tool list in the Mill Classic Tool Manager, and select Import/-
export tools, Import tool data from, and select the appropriate import option.

This launches another dialog box to allow you to select the tools you wish to import.
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Importing with CoroPlus
When selecting CoroPlus from the right-click menu, the CoroPlus Tool Importer con-
nects to the CoroPlus local host server and displays a list of all the tools that you have
in CoroPlus' Assemblies list.

The cloud icon in the second column indicates that the associated tool assembly has
not been validated.
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To bring one or more tools into your Mastercam part or a .tooldb file, you select one
or more items from the list, and select Validate at the top of the CoroPlus Tool
Importer dialog box. If the tool assembly passes Mastercam's validation tests, you will
see a green checkmark indicating that it can now be saved. This also applies to import-
ing tools fromMachining Cloud (see "Importing with Machining Cloud" below).

If Mastercam detects problems with the tool, an icon will display indicating the sever-
ity of the problem. A red X indicates that there is a critical issue that must be resolved
first. A yellow exclamationmark indicates a non-critical warning. Use the hyperlink in
the description field to review or edit the tool in question.

Importing with Machining Cloud
When selecting Machining Cloud from the right-click menu, the Machining Cloud Tool
Importer dialog box displays. The importer does not connect to a server process;
instead, you import ZIP files containing your tool assemblies using the Open button.
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Similar to importing with CoroPlus (see "Importing with CoroPlus" on page 78), all
assemblies must be validated before they can be used in Mastercam.
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MILL ENHANCEMENTS

Listed below are Mill enhancements made to Mastercam 2018. This includes improve-
ments to the 2D, 3D, andMultiaxis suite of toolpaths.

General Enhancements
Listed below are enhancements that apply to Mill toolpaths in general, not just 2D or
3D toolpaths.

Drill point sorting
Sort by name has been added to the Drill Point Manager right-click menu. This allows
you to reset the sort order to the original selection order or in the order you have
named the drill points.
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This is accessed through any toolpath that uses the Drill Point Manager, such as a 2D
Hole making toolpath, Multiaxis Drill, or Multiaxis Circle Mill.

Override arc feed rate
You can now select to override the arc feed rate on the Arc Filter / Tolerance page of
the following toolpaths:

l 2D Contour

l Slot Mill

l Waterline

As the tool moves through relativity small inside arcs, the perimeter of the tool is mov-
ing through the material faster than the center of the tool. When the cutter moves
through outside arcs, the perimeter of the cutter is moving through the material
slower than the center of the tool, which results in a decreased chipload on the tool.

By selectingOverride Arc Feed Rate and entering aMax ID decrease or aMax OD
increase value, Mastercam will adjust the feed rate for inside arcs and increase the
feed rate for outside arcs by using the current motion's arc radius and the cutter size
to calculate the proper feed rate.
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2D Enhancements
Listed below are enhancements made to the 2D suite of toolpaths.

Contour enhancements
The following enhancements apply to the standard 2D Contour toolpath.

Chamfer tool offset

In previous versions, you could only modify the Tip offsetwhen chamfer milling, allow-
ing you to control how far past the bottom chamfer rail the tip of the chamfer tool
extends.

In 2018, Mastercam supports options to offset from the top or the bottom of your
chamfer rail. Top offset places the full diameter of the chamfer tool at a specified dis-
tance above the top rail of the chamfer. Bottom offset amount ensures the tip of the
tool clears the bottom of the chamfer.Width has also been renamed to Chamfer
width.
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You can also now enter 0.0 for the Chamfer width when using a chamfer tool. This
allows you to chain the top or bottom rail of an existing chamfer and place the cham-
fer where you desire using the top or bottom offset value.

Machine finish passes

SelectMachine finish passes after roughing all contours on the Multi Passes
page to machine finish passes after all rough cuts and depth cuts have been com-
pleted.

Multi pass order

In Mastercam 2017, multi passes were only ordered By contour, meaning it com-
pleted one chain before moving on to the next. In 2018, you can now choose By con-
tour or By pass on the Multi Passes page.

By pass orders the multi passes by pass number. It will run the first multi pass on all
contours, then the secondmulti pass on all contours, and so on.
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Rough pass cut direction

You can now control the cut direction of rough passes on the Multi Passes page.
Select either One way or Zigzag. One way causes the roughmulti passes to behave
as they did in past versions. Zigzag will alternate the cut direction between climb and
conventional.

Both options respect the Keep tool down option.

Depth cut direction
Contour, Circle Mill, Pocket, and Facing toolpaths now support a Step up or Step
down depth cut direction, located on the Depth Cuts page. These options allow you to
order your cuts from top to bottom or from bottom to top.
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Depth cut order
Similar to Contour and 2D Pocket, you can now set the depth cut order By region/By
contour or By depth on the Depth Cuts page for the following toolpaths:

l Dynamic Mill

l Area Mill

l Dynamic Contour

By depthmachines at each Z level for all machining regions before stepping down.
By contour and By regionmachine eachmachining region to completion before mov-
ing to the next.

Finish passes
Two options are now available on the Multi Passes page for Contour and the Finishing
page for Circle Mill toolpaths. In previous versions, you could only machine finish
passes at all depths or at the final depth. Now you can add or remove finish cuts,
based on the number of rough depth cuts specified on the Depth Cuts page.
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Add between creates a finish pass at all depth cuts and adds a specified amount of
passes between depth cuts. For example, when set to 2, Mastercam adds two evenly
spaced passes between depth cuts. In the image below, the red lines represent depth
cuts and the blue lines represent multi-pass finish passes.

Per number of adds a finish pass only at every specified depth cut. A multi-pass fin-
ish pass is always added to the last depth cut. When set to 2, Mastercam adds a finish
pass only at every second depth cut, depicted by the blue and red lines together
below.
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Linking associativity
You can use associative points to program your linkingmoves for most 2D toolpaths.
These new features are located on the Linking Parameters page.

For example, if the top of a feature should be cleared by a certain amount, you can
enter a Clearance amount, select Associative, and then pick a point on the feature in
the graphics window. The Clearance plane will always be the specified incremental
value above the point, even if the feature is moved.

The following toolpaths do not use the associative points:

l Point

l Engrave
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l All Wireframe toolpaths (Ruled, Lofted, Revolved, Coons patch, Swept)

Plunge entry support
Plunge entry is now supported for Dynamic Mill toolpaths. Set the Entry method to
Plunge only on the Entry Motion page. This option allows you to plunge directly into
material. Previously, you had to set Entry method toHelix and the Plunge angle to
90°.
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Spring passes
Spring passes has been added to the Finish Passes, Finishing, Multi Passes, or
Rough/Finish page of the toolpaths listed below. Spring passes create additional fin-
ish passes along the same path as the last finish pass. In other words, use this option
to create additional finish passes with a spacing of zero between the passes. This can
used for parts with thinmaterial that may have flexed away from the tool during pre-
vious passes.

l Dynamic Contour

l Peel

l Blend

l Contour

l Slot Mill

l Circle Mill
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Stock awareness
Stock awareness has been added to 2D Drill, ThreadMill, Helix Bore, and Circle Mill.
The tool motion can now use the top, bottom, or both values of the stock. All of the link-
ing parameters can be set to adapt to changing stock values.

Undercut support
SelectUndercut (undercut tool only) when using an undercut tool to support tool
compensation. This option is available on the Depth Cuts page for Contour, Pocket,
Face, and Circle Mill toolpaths.

When a slot mill tool, withUndercut (undercut tool only) and Step up selected,
there are the following changes:

l Stock to leave becomes inverted. It becomes a distance in -/+ Z direction
from the top of stock location.

l Break through becomes inverted. It becomes a distance in -/+ Z direction
from the top of stock location.

Taper support
Circle Mill toolpaths now support tapered walls. Select Tapered walls on the Depth
Cuts page to angle depth cuts from the top of the stock to the final depth.
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3D Enhancements
Listed below are enhancements made to the 3D suite of toolpaths.

Disable undercut tool support
When you select an undercut tool, but do not want to machine the undercut area,
select Detect undercuts on the Rough Parameters tab for Surface Rough Pocket and
on the Finish contour parameters tab for Surface Finish Contour. Detect undercuts
disables undercutting when using an undercut tool.
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Follow containment
Follow containment has been added to the Steep/Shallow page for Waterline
toolpaths. This option is only available when Contact is set to Tool assembly contact.

Follow containment allows the tool to follow the containment boundary back to the
start of the cut, creating clean closed passes. This also helps to avoid partial cuts
when a containment boundary was directly on top of a vertical surface.

High speed workflow
The workflow for all 3D High Speed toolpaths has been streamlined. You can now
define which part geometry to machine and which geometry to avoid. For each geo-
metry group you create, you can also assign variable stock to leave values on its walls
and floors.

What'sNew in Mastercam 2018—Mill Enhancements



When selecting any of the 3D High Speed toolpaths, you are immediately brought to
the Model Geometry page in the toolpath dialog box.

Use the Model Geometry page to create different types of geometry groups and
define their attributes, such as color and the amount of stock to leave.

All of the geometry selection options that were previously located on the Toolpath
Type page have been removed and relocated to the Model Geometry page or the
Toolpath Control page.
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The Toolpath Control page also includes options that were previously located on the
Tool Containment page, which has been removed. On this page, you can further refine
your toolpath by setting an Approximate start point, the Strategy, and other
options.
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Smoothing
The high speed Hybrid toolpath now offers smoothing controls, similar to the Sharp
corner smoothing options for the Finish Scallop toolpath. Select Smoothing on the
Cut Parameters page to enable these options.

Angle is the minimum angle between two toolpath segments that you want Master-
cam to consider as a sharp angle. Blend distance is the distance Mastercam will
back away from the sharp corners before and after.

Smoothing off Smoothing on
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Multiaxis Enhancements
Listed below are enhancements made to the Multiaxis suite of toolpaths.

Collision Control page
The Collision Control page has been redesigned for 2018. The following list encom-
passes the changes made:

l Strategies 3 and 4 have beenmoved to a new Additional Collision Control
Strategies page.

l Items on the Advanced Parameters page have beenmoved to the Collision
Control page.

l The Tool Clearance page has been removed, and its parameters are now on
the Collision Control page.

l Shaft has been renamed to Shoulder.

l Arbor has been renamed to Shank.
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Common direction
Common direction has been added to the Tool Axis Control page, which keeps the
tool at a uniform tilt angle to reduce tool andmachine motion. It is available for the fol-
lowing toolpaths:

l Morph

l Parallel

l Along Curve

l Triangular Mesh

l Project Curve
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Select Common direction and then choose either On all contours or On single con-
tour.

Dropping
Dropping has been added to the 3 to 5 axis toolpath. This option projects the 3 axis
toolpath onto the selected surfaces, adjusting the tool vectors to be normal to the sur-
face.
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Line distance from curve
An option has been added to the Tool Axis Control page when using Lines for tool axis
control for a Curve toolpath. This distance specifies how far from the curve a tool axis
control line can be and still affect the tool.

Maintain tilt
Maintain tilt keeps the tool tilted during retract and feedmoves in an effort to
reduce tool andmachine motion. This option is available when Tool axis control is
set to Fixed angle to axis on the Tool Axis Control page.

This option is available for the followingMultiaxis toolpaths:
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l Morph

l Parallel

l Along Curve

l Triangular Mesh

l Project Curve

l 3-to-5 axis

Multiaxis Link Safety Zone
The Multiaxis Link Safety Zone page has been redesigned. The images have been
updated to better reflect the parameters, and a newDefine Shape button has been
added.
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Select Define Shape to open the Safety Zone function panel, where you can alter and
manipulate the safety zone to suit your needs.

Surface edge tolerance
Surface edge tolerance has been improved, particularly when creating a Curve
toolpath. If the curve lies on the edge of a trimmed surface or solid face, and the sur-
face or solid face is used as the normal to control the tool axis, the toolpath will gen-
erate as expected.
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LATHE ENHANCEMENTS

Listed below are Lathe enhancements made to Mastercam 2018.

Chip Break
Chip Break, which was introduced in Mastercam 2017 for standard Rough and Con-
tour Rough toolpaths, is now available for Face and Finish toolpaths. Use this option to
establish when chip breaks occur.
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Chip Break is located on the Finish parameters and Face parameters tabs, respect-
ively. Select the checkbox, and click Chip Break to open the dialog box. This option is
valuable when working with stringy materials, such as aluminum or plastic, and allows
you to set length and time conditions, retract, and dwell options.

Chip Break on

Chip Break off
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Groove Enhancements
Listed below are the enhancements made to the Groove toolpath.

Cut direction options
The Bi-Directional option on the Groove rough parameters tab has been changed to
Bi-Direction, Alternating. With this option selected, after the toolpath's initial
plunge, it alternates between negative and positive directions until the requiredmater-
ial is removed.

The following options have also been added to the Cut Direction drop-down:

l Bi-Directional, Positive First: Machines the positive side first and then does
the negative.

l Bi-Directional, Negative First: Machines the negative side first and then
does the positive.

l Chain Direction: Machines in the direction of the chain.

Starting location
When cutting a face, Mastercam now calculates the optimal plunge point so that each
side of the tool removes the same volume of material. This balances wear between
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the two sides of the tool. Shown below, the initial plunge point is offset so that the
remaining stock has an equal volume on the X+ and X- side.
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Prevent Up Cutting
Prevent up cutting defines the orientation of the non-cutting portion of the insert.
This option is available on the Dynamic rough parameters tab for Dynamic Rough
toolpaths.
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For example, in the image below, you can see the tool shank crashing into the mater-
ial as it tries to cut the toolpath.
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When Prevent up cutting is selected and Angle is set to 0 degrees, Mastercam gen-
erates a toolpath that cuts only with the lower portion of the tool insert.
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Rough Enhancements
Listed below are enhancements made to the standard Rough toolpath.

Section turning
Lathe Rough now has a Section turning option, located on the Rough parameters
tab, that lets you cut stock inmultiple sections. You can choose to break the toolpath
into equal sections, into sections of exact distance with one section being the
remainder, or equal sections based on the given distance.
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Section turning off

Section turning on (Set to Exact length)
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Semi-finish speed and feed
You can now set different feeds and/or speeds for the semi-finish pass in the Semi Fin-
ish Parameters dialog box for a standard Rough toolpath. To access this dialog box,
select the checkbox, and select Semi Finish on the Rough parameters tab.

Stock Model Support
The Stock Model operation now supports Lathe andMill-Turn part-handling oper-
ations. After the part handling operations complete, the stockmodel will end up with
the stock boundary.

Tool Inspection
You can now perform a tool inspection at the end of a standard Rough toolpath. Addi-
tionally, Tool Inspection has been added to the Face toolpath on the Face para-
meters tab.
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MILL-TURN ENHANCEMENTS

Listed below are Mill-Turn enhancements made to Mastercam 2018. This includes
improvements to Job Setup, tool locators, and new toolpaths.

Center Support
Mastercam now supports center tool definitions, and you can now create a Center
Point and Tailstock operation.

Right-click in a tool list and select Create center to create a center tool using the Tool
Wizard, by defining the parameters manually or by importing custom geometry from
a file.
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Also, when creating a Tailstock or Center Point toolpath, the center tool will display in
the graphics window.

New Center Point toolpath
With the support for center tools, you can now create a Center Point toolpath. This
new toolpath is located on theMill-Turn Turning contextual tab in the Part Handling
gallery.
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This toolpath is used when you need to mount a center tool in a turret and engage the
tool for live center support.
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New Tailstock Operations
With the support for center tools, you can now create Tailstock Operations. This new
toolpath is located on theMill-Turn Turning contextual tab in the Part Handling gal-
lery.
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Use Tailstock Operations to quickly create a set of operations to load a center tool,
move to stock clearance and, if applicable, advance the quill. The available tailstock
options differ depending on the selectedmachine. For example, not all machines
allow quill actions.

You can also create a set of tailstock operations to retract the quill and tailstock, and
unload the center tool.

General Enhancements
l Edit common parameters is now available in Mill-Turn. Right-click on a toolpath

in the Toolpaths Manager and select Edit selected operations, Edit common
parameters to display the Edit Common Parameters dialog box.

l If you import an operation, Mastercam will check the Work Coordinate System
(WCS) of the operations.

l You can now chain geometry onmultiple planes, similar to Lathe chaining. All
features can be toolpathed onmultiple sides in one operation.
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Job Setup Enhancements
Listed below are enhancements made to Job Setup.

Enable destination spindle
Select Enable Right Spindle or Enable Left Spindle when you want to use the
second spindle for a stock pull. It is only available when the Stock Type - Part Hand-
ling is set toNo Pickoff on the Setup Type page. The name of this optionmay vary
depending on the Stock Type - Part Handling selected.
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Manually define stock
SelectManually Define Right Spindle Stock on the Setup Type page to choose the
stock for the second spindle, which is the stock that shows in simulation when it is
launched. This entity can be derived from a stockmodel that reflects the initial
spindle's operation.

STL models
You can now use STL models to define stock.
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Stock Type - Part Handling
You can now select Two Separate Parts in the Stock Type - Part Handling drop-
down, in addition to Continuous Bar Stock and Single Pieces of Stock. This allows
you to machine different parts on the left and right spindles.
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Tool Locators for B-axis Heads
Mastercam 2018 now includes support for tool locators for B-Axis heads. Spindle tool
locators enable proper positioning of tools in the B-axis head. In Mastercam 2017, a
tool in the B-axis head would generally have its compensation point along the center-
line of the head.

This support greatly improves collision detection and a clear representation of the
how the tool is mounted in the machine.
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Additionally, multi-station tool locators are supported. This allows for realistic sim-
ulation of machine tool change motion. Instead of moving all the way to the tool
change position, the spindle canmove to any point you specify, index the locator, and
quickly get back to cutting. These new locators are fully utilized in collision detection,
including all tools mounted in the locators regardless of which tool is currently cutting.

The Tool SetupManager also supports spindle tool locators.
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ATTENTION! UPDATES MAY BE AVAILABLE.
PLEASE REFER TO MASTERCAM.COM/SUPPORT

FOR THE LATEST DOWNLOADS.

http://i.youku.com/Mastercam
https://www.instagram.com/mastercamcadcam/
https://www.linkedin.com/company/cnc-software?trk=company_logo
https://plus.google.com/+mastercam
https://www.youtube.com/user/MastercamCadCam
https://twitter.com/mastercam
https://www.facebook.com/Mastercam/

	Introduction
	Product Changes
	Mastercam Resources
	Contact Us


	General Enhancements
	Analyze Enhancements
	Analyze Toolpath
	Analyze Distance Along Curve
	Lathe coordinates
	Propagate arc radius
	Statistics

	Bounding Box Face Points
	Command Finder
	Create New Viewsheets
	Create Plane Dynamically
	Delete Duplicates
	Dimmed and No Hidden Wireframe
	Endpoints
	General Toolpath Enhancements
	Improved access to chaining tolerance
	Probe operation associativity
	Stock display

	Guided Chaining
	Importing/Exporting Enhancements
	CATIA Translator now imports hidden entities
	Keep names when exporting solid bodies
	Naming levels and solid bodies from imported solid assemblies
	New options available when importing STL files

	Levels Manager
	Ignore blanked entities in count
	Import via drag and drop

	Mastercam Simulator
	Create bookmarks
	Create presentation
	Machine Simulation

	My Mastercam
	Named Groups Quick Mask
	Nesting Enhancements
	Create labels
	New location for temporary files
	User-defined maximum priority

	New Plane/Edit Plane Function Panel
	Planes Manager
	Import via drag and drop
	Isometric reverse and trimetric planes

	Saving Files Workflow
	Mastercam control definition files
	Mastercam machine definition files
	Mastercam part files

	Selection Enhancements
	Enhanced solid and surface selection
	Selection masking for sheet bodies
	Similar face selection
	Window selection support

	Setup Sheet Enhancements
	Additional image support
	Viewsheets and levels support

	Social Media Links
	System Configuration
	Default file open type
	Selection window color

	Update to Parasolids 29.1
	User Interface Changes
	Work Offsets
	XML Post Text

	Design Enhancements
	Angle Sweep
	Seam Control
	Drafting Enhancements
	Align Note
	Cross Hatch
	Leader
	Smart Dimension

	Model Prep Enhancements
	Hole Axis
	Multiple Undo/Redo

	Solid Enhancements
	Solid Sweep
	Solids Manager
	Keep solid feature color
	Solid face masking

	Transform Enhancements
	Control start position
	Scale conversion

	Wireframe Enhancements
	Curve creation
	Create Letters
	Edit Spline
	Helix and Spiral
	Line Endpoint
	Modify at Intersection


	Tool Enhancements
	Improved Inch and Metric Support
	New Tool Importers
	Importing with CoroPlus
	Importing with Machining Cloud


	Mill Enhancements
	General Enhancements
	Drill point sorting
	Override arc feed rate

	2D Enhancements
	Contour enhancements
	Depth cut direction
	Depth cut order
	Finish passes
	Linking associativity
	Plunge entry support
	Spring passes
	Stock awareness
	Undercut support
	Taper support

	3D Enhancements
	Disable undercut tool support
	Follow containment
	High speed workflow
	Smoothing

	Multiaxis Enhancements
	Collision Control page
	Common direction
	Dropping
	Line distance from curve
	Maintain tilt
	Multiaxis Link Safety Zone
	Surface edge tolerance


	Lathe Enhancements
	Chip Break
	Groove Enhancements
	Cut direction options
	Starting location

	Prevent Up Cutting
	Rough Enhancements
	Section turning
	Semi-finish speed and feed

	Stock Model Support
	Tool Inspection

	Mill-Turn Enhancements
	Center Support
	New Center Point toolpath
	New Tailstock Operations

	General Enhancements
	Job Setup Enhancements
	Enable destination spindle
	Manually define stock
	STL models
	Stock Type - Part Handling

	Tool Locators for B-axis Heads


